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Chapter 1: Introduction

This document describes the New and Improved Features in S6 Software v19.7 for Pro Tools® | S6 systems. 

System Requirements and Compatibility
S6 Software version 19.7 requires the following: 

• Valid S6 software license
• Pro Tools and Pro Tools | Ultimate 2019.5 or later (2019.6 required for some fixes)
• Or other EUCON™-enabled applications (check with the manufacturer for compatibility information and requirements). 

For a list of supported applications, system requirements, and other compatibility information, visit:
http://www.avid.com/products/pro-tools-s6/specifications

DAW Compatibility At the time of this writing, S6 Software v19.7 is compatible with the following (or later versions): 
• Avid Pro Tools and Pro Tools | Ultimate 2019.5 or later (2019.6 required for some fixes)

• Steinberg Nuendo 7 and Cubase 8 or later
• Apple Logic 10 
• Magix Sequoia 14
• Merging Pyramix 8.x Native only, and Pyramix 9.x
• Avid Studio Monitor Pro
• Avid XMON S6
• Pro Tools | MTRX and ProMon (DADman) for Pro Tools | MTRX and NTP Technology AX32

WSControl Application Compatibility macOS 10.12 or higher (including macOS 10.12/”Sierra”, 10.13/“High Sierra” and 
10.14/”Mojave”) and Windows 10 or higher. For the latest compatibility information, see Avid S6 Compatibility. 

On macOS 10.14/”Mojave” (only) you may be prompted to add applications such as Pro Tools to the Privacy list in System Pref-
erences. If so, follow the on-screen instructions. 

Important!

The EUCON performance improvements introduced in v3.5 make it and all later versions (including v19.7) incompatible with 
v3.4.x and previous versions of EUCON and EuControl. As a result, version 19.7 and future versions must not be run on the same 
network (subnet) as any 3.4.x or previous EUCON Surface software. 

• To get the latest version of EuControl software for S3, Dock, and Artist Series, download them from your Avid Account or 
visit: http://www.avid.com/en/products/artist-control/learn-and-support.

• For System 5-MC and MCPro, visit:
System 5-MC and MC Pro Documentation and Software. 

• For System 5, use version 6.1 or later. For more information, visit: 
http://avid.force.com/pkb/articles/user_guide/System-5-and-S5-Fusion

For System 5 software downloads, log in to your Avid Account or contact Avid support for details. 

Because of the major changes in S6 19.5 for attention and plug-in window workflows, there may be undesirable behavior with ear-
lier versions of Pro Tools. If using Pro Tools 2018.12 or earlier, consider disabling the new attention and plug-in window settings 
described later in this guide. 

http://avid.force.com/pkb/articles/Compatibility/Avid-S6-Compatibility
https://www.avid.com/account
http://avid.force.com/pkb/articles/user_guide/System-5-MC-and-MC-Pro
http://avid.force.com/pkb/articles/user_guide/System-5-and-S5-Fusion
https://www.avid.com/account
https://www.avid.com/learn-and-support/contact-audio-and-music-support
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Product Activation and Software License Activation
Activate your S6 system software on-line as instructed later in this guide. You must use the System ID on the included S6 System 
Software Activation Card to activate and download all S6 system software and documentation. You will also need to activate your 
S6 software license after installing the software. 

If you are upgrading a system, check your Avid account for the latest S6 system software. 

Software License Activation Information
After installing the new S6 MasterModule software, you might be prompted to activate or update your software license. S6 soft-
ware licenses are valid for the entire year of the currently valid Support Contract. 

In versions of S6 software prior to v3.5, a new license was required for each major release. All customers with current Support Con-
tracts who are upgrading from v2.2.1 or earlier must activate the new version by registering your System ID in order to transition 
to the new yearly license system and download the latest software. 

To receive your Activation ID, go to https://my.avid.com/products/Hardware/console and log into your Avid Account (or cre-
ate one). Follow the instructions on-screen to enter your System ID. For information about locating your System ID, see this article 
on our Knowledge Base: 

http://avid.force.com/pkb/articles/faq/How-to-find-S6-System-ID

Once the new version is activated, you will not need to activate a new license for any software updates that are released for the du-
ration of your current Support Contract. After you activate your license your Avid Account will be updated with the new S6 soft-
ware for you to download, and will also show your Support Contract dates.

About This Guide
This guide explains how to assemble your Avid S6 system.

Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The names of switches and keys on the control surface are shown in bold (such as Select). In addition, the Shift switch on the 
Master, Fader, or Joystick Module is always shown in bold to distinguish it from the Shift switch on the computer keyboard. 

The following symbols are used to highlight important information:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.
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How to Use this PDF Guide
These are some useful features of this PDF:

• The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page.
• Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns 
into a finger, then click to locate to that subject and page.

• All cross references in blue are active links. Click to follow the reference.

• Select Find from the Edit menu to search for a subject.

Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 
The following are just a few of the services and features available. 

Account Activation, Product Registration, and License Activation
Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your 
purchase online, download software, updates, documentation, and other resources. Activate your software license

https://www.avid.com/account

Support and Downloads
Contact Avid Customer Care (technical support); download software updates and the latest online manuals; browse the Compati-
bility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on the 
User Conference. 

https://www.avid.com/learn-and-support

For S6 support, trouble-shooting, and downloads, visit: 
http://avid.force.com/pkb/articles/faq/Avid-S6-Support

Training and Education
Study on your own using courses available online or find out how you can learn in a classroom setting at an Avid-certified training 
center. 

Videos on YouTube
Check out the new Avid Pro Tools | S6 Workflows and original Get Started Fast with S6 video tutorials, available on YouTube. 

Products and Developers
Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and 
hardware. 

https://www.avid.com/Products/index.html

News and Events
Get the latest news from Avid or sign up for an S6 demo. 

https://www.youtube.com/playlist?list=PLhCR_8aS9jOPO2WLom-lUkQjZgbW498Rf
https://www.youtube.com/playlist?list=PLhCR_8aS9jOPp-bo_wjYUpkBsVjiUH2gB
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Chapter 2: New and Improved Features in 
S6 Software v19.7

S6 Software v19.7 provides new and changed features in the following areas:
• Improved Display of Knobs from Most Recently Clicked DAW Area
• Additional New and Improved Features

Important!
The EUCON performance improvements introduced in v3.5 make it and all later versions (including v19.7) incompatible with 
v3.4.x and previous versions of EUCON and EuControl. As a result, version 19.7 and future versions must not be run on the same 
network (subnet) as v3.4.x or any previous EUCON surface software. 

• To get the latest version of EuControl software for S3 or Dock, download them from your Avid Account–or for Artist Series 
controllers visit:
http://www.avid.com/products/artist-control/learn-and-support

Video Resources on YouTube
Check out the new Avid Pro Tools | S6 Workflows on YouTube for in-depth explorations of how to use Layouts, Spill Zones, Ex-
pand Zones, and more. Check back frequently for updates to this ongoing series. 

S6 v19.7 may require a new software license. For instructions, see Updating S6 System and Workstation Software. 

Check the Release Notes for additional information. 

https://www.avid.com/account
https://www.youtube.com/playlist?list=PLhCR_8aS9jOPO2WLom-lUkQjZgbW498Rf
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Improved Display of Knobs from Most Recently Clicked DAW Area
The Display Knobs From Most Recently Clicked DAW Area setting lets you specify where you want clicked DAW controls to 
appear on S6 (such as only on the Master Module, on an Expand Knob Module, or on both the Master and Expand Fader). 

Beginning S6 19.7, Expand Fader Modules use the Primary and Backup Functions when clicked DAW controls do not have a cor-
responding knob type (such as clicking on Track Name or in the timeline). In addition to extending the usefulness of the Primary 
and Backup Function settings, this also prevents Attention Expand Zones from going blank in certain attention-via-click scenarios. 

Auto-Launch MTRX
MTRX has been added to the Auto-Launch choices in WSControl. When enabled, this will auto-launch DADman software (if pres-
ent) for Pro Tools | MTRX. 

Additional New and Improved Features
The following features were provided in S6 19.5.1. 

Improved Momentary Fader Value Display
Display of track name and values can be configured using the Show Timed Fader Values and Fader Value Timeout settings. In 
EUCON 19.5.1 these settings have been improved to provide more options to optimize name/value display. These settings are lo-
cated in the Strips section of the User > Settings page. 

To improve Momentary Fader Value display, the following new options have been added: 

Momentary Fader Value settings in S6 Settings > User 

Settings for Momentary Fader Value

Setting Description

Off Displays always show track name (ignore Fader Value Timeout)

While Fader is Touched Shows value when fader is touched and reverts to track name when released

Timed at Fader Touch, 
Off at Release

Shows value on touch, reverts to track name when the timer expires
• If the fader is released before the timer expires, the display reverts to name 
• If the Fader Value Timer slider is set to Off (full left), then values are not shown

Timed at Fader Touch

Shows value on touch, reverts to track name when the timer expires 
• If the fader is released before the Fader Value Timer setting expires, the display stays on value until the 

timer expires then reverts to name
• If the Fader Value Timer slider is set to Off (full left), then values are not shown

Timed at Fader Release
(default)

Shows the value while touched and continues to show value on release until the timer expires
• If the timer is set to OFF, shows value when fader is touched and reverts to track name when released 

(equivalent to ‘While Fader is Touched” option)
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Chapter 3: Updating S6 System and Workstation 
Software

The process for updating S6 software and activating the required software license involves these steps: 
• S6 Software Activation
• Logging in as Administrator and Updating Master Module Software
• Activating Your Software License
• Installing S6 Supporting Software

Network Configuration Settings
Installing a new version of S6 software overwrites any custom network settings you have configured. For example, if you have cus-
tomized the IP range for the local Master Module DHCP server, they will be reset to the 192.168.2.x range. If you have manually 
changed the S6 IP range you will have to re-enter your custom settings after installing the latest S6 software on the Master Module.

For additional information see the S6 Networking Guidelines.pdf, available for download from your Avid Account and from the 
Avid S6 Support article on our Knowledge Base. 

S6 Software Activation
1 (Required) If you have not already done so, use the System ID on the included S6 System Software Activation Card to activate 

your Avid account for S6: 
• Go to https://my.avid.com/products/Hardware/Console and log into your Avid Account 

(or create a new one, if necessary). 
• Enter the System ID number from the S6 System Software Activation Card (shown at right) in-

cluded in the Master Module package. 
Your System ID can be found on the S6 System Software Activation Card included in the front 
pouch of the S6 Installation Guide. Activating deposits your S6 software Activation ID number 
into your account, which you will use later to acquire your S6 software license, as well as soft-
ware downloads and documentation.

2 (Required) Acquire your S6 Software License. 
• Make sure you are still logged into your Avid Master Account at https://account.avid.com. 
• Retrieve your Activation ID number (My Products and Subscriptions > Pro Tools | S6 

M40/M10 Software and Support). You will use this number later to activate your new software license. 
• Download the latest versions of the S6 Master Module Software, Workstation software (Mac or Windows), and S6 documen-

tation from your Avid account to your computer. 
• Insert a USB flash drive into an available USB port on your computer.

• If necessary, extract (decompress) the .ZIP file containing the Master Module software to unzip it, then copy the resulting file 
(.exe) to the top (root) level of your USB drive. 

• Workstation software: If you will be using a different computer or computers for Pro Tools or other compatible DAWs, copy 
the appropriate Workstation software (Mac and/or Windows) to the top (root) level of the USB drive. 

• Remove (eject) the USB drive. 

These instructions apply to customers with support contracts who are entitled to the latest software release. If you are configuring 
a new S6 system for the first time, refer to the S6 Guide.pdf for complete network and configuration instructions. 

Do not use the System Restore USB drive! Use a separate USB flash drive. 

http://avid.force.com/pkb/articles/faq/Avid-S6-Support
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Logging in as Administrator and Updating Master Module Software
To install and update S6 Master Module software: 

1 If you have not already done so, navigate the touchscreen to the Settings > About page and press Logout. 

2 Select Administrator. When prompted enter the following default password: password

3 Click the File Explorer tile. 

4 Plug the USB flash drive with the downloaded S6 Master Module installer into one of the available USB ports on the back of 
the Master Module. The USB drive appears in the left hand column under Computer. 

5 Tap on the USB flash drive to see the contents. 

6 Launch (run) the S6MasterModuleInstall software from the flash drive by double-tapping on the icon.
Follow the instructions on-screen. After the installer has completed you will be prompted to restart the system. 

7 Tap Yes to restart the system immediately.
• If after restarting the Software License Activation screen appears, proceed to Activating Your Software License. 
• If not, proceed to Installing S6 Supporting Software. 

Activating Your Software License
S6 Master Module software is licensed and must be activated if prompted to do so after installation. If the Software License Acti-
vation screen appears, do the following to perform an Offline Activation. 

Offline activation requires a separate computer and USB flash drive. You can use the same USB flash drive on which you copied 
the S6MasterModuleInstall software. 

About Online Activation  Online Activation should only be performed while in direct contact with Avid Customer Support. 

Offline Activation
Make sure you have the System ID number and software Activation ID, and also make sure you have installed the new software 
and restarted your system.

To activate S6 software using offline activation: 

1 After the system has restarted, the Software License Activation screen appears. Help text appears in the lower half of the screen.

2 Make sure Offline is selected for the Activation Type. If not, tap the selector and choose Offline. 

Do not use the System Restore USB drive! Use a separate USB flash drive. 

Figure 1. S6 Software License Activation screen for offline activation
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3 On a separate computer go to http://www.avid.com/license to access the Software License Activation page. 

4 Enter the following information, making sure to enter all characters and numbers correctly (fields are not case-sensitive):
• Enter your Activation ID into the Activation ID field. Once entered, a System ID field appears. Press Tab to go to the next field. 
• Enter your System ID into the System ID field. Press Tab to go to the next field. 
• Enter your Device ID (shown on the S6 Software License Activation screen) into the Device ID field. 
When a valid ID number is entered into each field, a green check mark appears. If any characters are incorrect, and until the cor-
rect number of characters has been entered, an error message appears. 

• (Optional) Enter the email address associated with your Avid account to receive an email with a copy of your license file. 

5 Click Submit, then follow the instructions on-screen to do the following: 
• Download the license file (.bin) to your computer, then transfer the license file to a USB flash drive. 

• Remove the USB drive from your computer, then insert it into one of the USB ports on the back of the Master Module. 

6 On the S6 touchscreen, tap Activate. A standard Windows Open dialog appears. 

7 Navigate the dialog to the USB drive, select the downloaded license file (“S6xxx.bin”) and tap Open. 
After a few moments your software will be activated. 

8 After activating your software, if you are prompted to update module firmware after the system restarts do the following: 
• Navigate to the Settings > Surface page and press Update.

• When prompted, confirm the update and then wait until all modules have updated (which can take several minutes). Do not 
turn off any modules during this process. The screen displays a message confirming that the update has completed.

9 Proceed to Installing S6 Supporting Software.

Figure 2. Software License Activation page

Do not use the System Restore drive. Use a separate USB flash drive (not included), formatted as FAT or FAT32. 

If no Update option is displayed either the system hasn't completely booted yet, or a module is selected on that screen. Wait for 
the system to finish starting up, and be sure no module is selected on-screen (indicated by a lit rectangle surrounding that module). 
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Installing S6 Supporting Software
Your Avid Master Account also provides workstation software for Windows and Mac, and S6 documentation. XMON EUCON 
and Studio Monitor Pro2 software options are included in these installers. Whenever you update S6 system software you must also 
update workstation software on all connected workstations. 

After updating S6 system software, do the following: 

1 If you have not already done so, on a separate computer navigate to https://account.avid.com, log in to your Avid Master Ac-
count (or create one if you have not already done so), and download EUCON_WorkstationUnifiedInstall software for your 
workstation (Mac or Windows), documentation, and other resources from the My Products and Subscriptions section under 
Pro Tools | S6 Software and Support. 

2 If necessary, transfer the EUCON_WorkstationUnifiedInstall to a USB flash drive. 

To install WSControl (workstation) software: 

1 Insert the USB drive containing the downloaded EUCON_WorkstationUnifiedInstall into a USB port on your workstation. 

2 Navigate to the USB drive and double-click EUCON_WorkstationUnifiedInstall, then double-click the installer to launch it. 

3 Follow the instructions on-screen (select each option you want to install):
• To only install S6 Workstation software, click to select its option. 

• If you will be using S6 and the Control app simultaneously, select both S3/Dock/Artist/PT | Control and S6 Workstation. 
(Other combinations are allowed (such as S6 Workstation and EUCON Workstation software) but once installed cannot be 
run simultaneously.) 

4 Configure S6 Workstation software to auto-launch (click the S6 icon in the Tool bar (Mac) or system tray (Windows) and select 
S6 Workstation from the Auto Launch sub-menu). 

To uninstall items: 

1 Launch the installer.
Items that are currently installed are selected (checked) and indicated as Installed. 

2 Do the following: 
• To uninstall specific component, make sure it is not selected (no check mark).
• To uninstall all EUCON applications, select Uninstall all applications. 
• To uninstall all User Preferences, select Uninstall User Preferences (your appsets will not be removed). 

3 Click Continue (Mac) or Next (Windows). 

EUCON installs into a default directory for all EUCON devices (including, Artist Series, S3, and S6). This lets you co-install all 
software for these devices (you do not need to uninstall and re-install EUCON software when switching between different EU-
CON control surfaces). 

You can download these components directly to the workstation(s) you plan to use with S6, or to a USB flash drive. 

Do not use the S6 System Restore USB drive! Use a separate USB flash drive. 

Installing S6 Workstation software
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Chapter 4: Release Notes

For Pro Tools® | S6 Systems
• For information about what has been fixed, see Issues Resolved in S6 19.7. 
• For information about issues that may affect S6 performance, see Known Issues. 

Compatibility
S6 Software version 19.75 requires the following: 

• Valid S6 software license
• Pro Tools 2019.6 or later
• Or other EUCON™-enabled applications (check with the manufacturer for compatibility information and requirements). 

For a list of supported applications, system requirements, and other compatibility information, visit:
http://www.avid.com/products/pro-tools-s6/specifications

DAW Compatibility At the time of this writing, S6 Software v19.7 is compatible with the following (or higher versions): 
• Avid Pro Tools and Pro Tools | Ultimate 2019.6 or later is required

• Steinberg Nuendo 7 and Cubase 8 or later
• Apple Logic 10 
• Merging Pyramix 8.x Native only, and Merging Pyramix 9.x
• Avid XMON S6
• Pro Tools | MTRX and ProMon (DADman) for Pro Tools | MTRX and NTP Technology AX32
• Avid Studio Monitor Pro (no longer installed)

WSControl Application Compatibility The WSControl application is compatible with macOS 10.12 or higher (including macOS 
10.12/”Sierra”,10.13/“High Sierra” and 10.14/”Mojave”) and Windows 10 or higher. Check compatibility for individual 
EUCON-compatible workstation software. On macOS 10.14/”Mojave” (only) you may be prompted to add applications such as 
Pro Tools to the Privacy list in System Preferences. If so, follow the on-screen instructions. 

For the most current compatibility information, visit: Avid S6 Compatibility

Important!

The EUCON performance improvements introduced in v3.5 make it and all later versions (including v19.7) incompatible with 
v3.4.x and previous versions of EUCON and EuControl. As a result, version 19.7 and future versions must not be run on the same 
network (subnet) as any 3.4.x or previous EUCON Surface software. 

• To get the latest version of EuControl software for S3, Dock, and Artist Series, download them from your Avid Account or 
visit: http://www.avid.com/en/products/artist-control/learn-and-support.

Because of the major changes in S6 19.5 for attention and plug-in window workflows, there may be undesirable behavior with ear-
lier versions of Pro Tools. If using Pro Tools 2018.12 or earlier, consider disabling the attention and plug-in window settings. 

http://avid.force.com/pkb/articles/en_US/Compatibility/Avid-S6-Compatibility
https://www.avid.com/account
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Software Installation and License Activation Information
S6 Master Module software requires a valid license. If after installing S6 software you are prompted to Activate, follow the instruc-
tions on-screen to activate your S6 software license (see also Activating Your Software License). 

Important – Shutting Down the System
Whenever you need to manually shut down the system, always follow these steps. 

To shut down the system: 

1 Shut down the Master Module first. (Navigate the Touchscreen to Settings > About page, then touch Shut Down. Wait for the 
Master Module to completely shut down.)

2 Turn off power at the source device supplying power to S6 Power Strip (UPS, power conditioner or other). 

Restoring the System If you ever need to perform a System Restore, be sure to power cycle the entire system after the System Re-
store is completed. 

Issues Resolved in S6 19.7
• When Bank by Whole Surface is enabled and you bank a Spill Zone, the zone now banks by the number of strips in the zone, 

not by the size of the entire surface (GWSW-10932)

• Surface > Config pages could fail to show the setting for frame Depth (GWSW-12645)

• It was possible for WSControl to become “deadlocked” and cause surface freezes, especially in larger sessions (GWSW-12608)

• On-screen controls in XMON software could appear to not respond to surface controls (GWSW-12512)

Issues Resolved in Previous Versions of S6 Software
The following issues were resolved in previous versions of S6 software. 

What Was Fixed in S6 19.5.1
• Some S6 M10 system licenses could fail after upgrading to v19.5 (GWSW-12430)

• VCA bus knobs could fail to update displayed values (PT-251990)
Requires Pro Tools 2019.6

• Show Momentary Fader Values could fail to show parameter values as it had in previous versions (GWSW-12427, 
GWSW-12438)
To improve Momentary Fader Value display, new options have been added to support the Fader Value Timeout slider. See 
Further Improved “Open Windows on Workstation Attention” Setting. 

• Navigating in the Pro Tools Edit window using the “p” or “;” keys could fail to maintain track Attention and/or window focus 
(GWSW-12433)

• Functions not set to open windows could fail to close windows (GWSW-12453)
Requires PT 19.6

Issues Resolved in S6 19.5

General
• Session close times vastly improved.

• Large session performance improved.

• Mac network status could display the bandwidth from the wrong network connection (GWSW-11715)

• Front/Rear link Sel switch LED could remain off when link was enabled in Pro Tools until the switch was toggled off and back 
on (PT-247161)

• Pro Tools Snapshot names could fail to be shown (GWSW-11753)

Always shut down the Master Module before powering down the system!
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• In and Sel switches could fail to function across all knob page tables (GWSW-11685)

• It was possible for Fader Module Input LEDs to become stuck when banking or nudging (GWSW-11602)

• When connecting multiple workstations it was possible for a Spill zone to appear active even though it was not (GWSW-11532)

• It was possible for the plug-in window to not open after using Auto Insert EQ/Dyn (GWSW-11634)

• The Pan graph display on Master, Joystick, and Display Modules could differ from the corresponding pan display in Pro Tools 
(GWSW-11681)

• It was possible for a locked strip's pan to become unable to be adjusted from the Process Module (GWSW-11647)

• Pan parameters could fail to appear on the surface after loading a session with unavailable buses (GWSW-10904)

• The Clear Clip LED could incorrectly indicate a clip had occurred in Pro Tools (GWSW-11609)

• It was possible for the Preview LED to fail to indicate Preview mode after re-arranging tracks via banking or spilling 
(GWSW-11613)

• Track automation mode could fail to be indicated correctly in Flip mode (GWSW-9348)

• After updating Master Module software it was possible for modules displays to redraw inconsistently (GWSW-9084)

Soft Keys and Appsets
• It was possible for user created “Jump to page” soft keys to be unable to edit until an additional command was added to the soft 

key definition (GWSW-11588)

• Exiting Screening mode could cause faders to fail to reactivate (GWSW-11683)

Layouts
• Layouts and User settings could fail to store or load from sessions (GWSW-11603)

• It was possible for the Layout option Save to Current Slot to invalidate the last recalled layout in the title (GWSW-11589)

Display Modules
• Master Display Meter Modules: Waveform data could fail to re-appear when switching between different numbers of rows 

(GWSW-11628)

Monitoring
• If the monitor section was locked on one DAW (such as XMON or DADman) connecting another workstation could unlock it 

and lock it to the newly focused monitoring application (GWSW-11620)

• The monitor section could remain locked after its associated WSControl application was disconnected (GWSW-11645)

• Quitting and restarting XMON on Mac could cause XMON settings to be reset to default (GWSW-11631)

Master Post Module
• While controlling tracks on multiple workstations it was possible that the MPM Master Record would not come out of record 

when the last track was taken out of record (GWSW-11643)
Reminder: The Master Post Module is only supported with Pro Tools. In addition, Pro Tools needs to be in “PEC/DIR Style 
Input Monitoring” mode (Setup > Preferences, Operations tab). 

• Master record would not work when banked off the surface (GWSW-11747)

Master Joystick Module
• It was possible for Master Joystick Module knob assignment to be lost after a track without a pan function was assigned 

(GWSW-11605)

Issues Resolved in S6 v18.3

General
• Fader automation LED no longer incorrectly light green when a knob is in Preview (GWSW-10975)

• When assigned to faders, two-state switches could flicker and not change switch state (GWSW-11012)

• Nudging a Layout beyond the last strip in a spill zone could collapse the spill (GWSW-11016)
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• When loading a Title with Layouts that included track assignments from multiple workstations, it was possible for some strip 
assignments to initially appear empty (GWSW-11040)

• It was possible for a Layout to initially load without any assigned tracks (GWSW-11518)

• Spilling a Layout in which no tracks were assigned to a Spill Zone could collapse the Spill Zone (GWSW-11265)

• Recalling Layouts that contain Master Display Meter assignments is now faster (GWSW-11052)

• If a session was saved after recalling a Layout and then activating a Spill Zone, it was possible for the Layout to fail to load 
(GWSW-11252)

• It was possible for S6 to appear frozen after switching Layouts in large sessions (200 or more tracks) (GWS-11336)

• If Flip was active on a Process Module or Knob Module and then canceled, the knob would not exit Flip mode (GWSW-11021)

• Clearing Send level no longer focuses the control on Send pan (GWSW-11078)

• It was possible for strip Lock to become unresponsive after initially locking a strip (GWSWS-11262)

• It was possible for the EQ graph in the Channel Strip plug-in to fail to update after displaying Listen (PT-233947)

• It was possible for S6 strips to display Gain Reduction meters for tracks that did not have relevant plug-ins (GWSW-6999)

• Dyn3 De-Esser parameters could become unavailable on Knob Modules (PT-233948)

Soft Keys and Appsets
• Pro Tools 12.x appsets were not recognized by Pro Tools 2018.x (GWSW-11331)

Display Modules
• Indication of Attention status in Expand mode now functions when multiple tracks are attentioned, such as when the same (at-

tentioned) track is on multiple strips in a Layout (GWSW-11094)

• It was possible for Master Display Meter Modules to display artifacts after recalling Layouts while configured with different 
numbers of rows (GWSW-11233)

Meter settings stored in layouts would sometimes update on the first recall only (GWSW-11328)

Issues Resolved in S6 v3.7

General
• Holding down the Fader Module Alt switch did not Do to All for pan functions Inverse F/R, Inverse F, Inverse R, Link, or F/R 

Link (GWSW-10954)

• Switching between workstations has been optimized and is now significantly faster than in previous versions. 

• The User 1 or User 2 switch LEDs (Expand Fader banking) could incorrectly remain lit after opening a different session 
(GWSW-10789)

• When switching between workstations using the Master Automation Module Soft Keys while the Focus Workstation of Most 
Recently Attentioned Track setting was enabled, it was possible for workstation 1 to remain focused (GWSW-10944)

• Nuendo: When viewing Track Types on the Master Automation Module Soft Keys, Input tracks had no icons (GWSW-10943)

Monitoring
• Speaker names could be unexpectedly reset to their default names after a source was selected twice (GWSW-10838)

Display Modules
• The track record indicator could fail to indicate correct status while in record (GWSW-10988)

• Dynamics “bouncing ball” would not always display on Display Modules when in Attention Expand mode (GWSW-10978)

Master Post Module
• It was possible for the PEC/DIR Page <> lights to remain on after spilling and then collapsing a VCA with 10 or more members 

(GWSW-10987)
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Master Joystick Module
• In Pickup mode, it was possible to create unwanted automation jumps at the pickup point (GWSW-10976)

Note: Automation takeover now occurs when the white (joystick) dot intersects with the red dot. Previously, takeover occurred 
when the larger white circle surrounding the white joystick dot touched the red dot. 

Issues Resolved in S6 v3.6.1
• It could be difficult for some plug-in knobs to reach their maximum and minimum values (GWSW-10747) 

• It was possible for registry permissions issues to prevent WSControl from recognizing a workstation when installed on a clean 
Windows OS (GWSW-10785)

• Editing Network Ports on the Master Module required two reboots (GWSW-10627)

• It was possible for Windows 10 workstations to be listed as Windows 8 in Settings > Workstations (GWSW-10709) 

It was possible for the Automation Module wheel to become incapable of scrolling the Pro Tools MIDI Editor window vertically 
(GWSW-10479) 

Issues Resolved in S6 v3.6
• Some multiple Soft Key commands could fail if the first command was a page change for the same key (GWSW-10345)

• Master Post Module: It was possible for a Record Master strip to appear as assigned after unassigning (GWSW-10331) 

• Master Post Module: It was possible for the Record Master to not follow Link Master disarm or return to playback when multiple 
MPMs were set to mirror (GWSW-10664)

Issues Resolved in S6 v3.5
• MPM Input Monitor switching on linked tracks was not simultaneous (GWSW-9936) 

• EUCON SHIFT modifier could get stuck On if used as a Soft Key modifier to open a dialog box (GWSW-9697)

• Knobs could get out of sync when writing automation in Touch modes (GWSW-10322)

Switch Labels for Reassigned Default Soft Keys
If you own an S6 Automation Module with original text on Locate switches (Trim +, Trim -, Store Current, Store Locate, Edit, 
Recall, Delete, Clear) and you would like a set of 8 stickers with the new text (Mix/Edit, Faders Off, Trim Sel, Consol Clip, 
Edit Loc, Undo, Redo, Save) visit http://www.avid.com/S6stickers and fill out the brief form with your contact and shipping 
information. 

Known Issues
The following are known issues you may encounter using S6, along with workarounds if they exist. 

• Downgrading from 3.6 to 3.5 (GWSW-10593)
If you uninstall S6 v3.6 and then install v3.5, startup can hang at “Loading Surface Preferences.” 
Workaround: Delete, rename or move the S6 Monitor Settings file, located at C:\ProgramData\Avid\S6\MonitorSettings. (By 
default, ProgramData is a hidden directory. To access it, open the View tab and enable Hidden items from the View tab.)

• Workstation Sleep causes problems with connectivity and performance
If workstations enter Sleep mode, communication and performance can be problematic until S6 and all workstations are 
power-cycled. 
Workaround: Set all connected workstations to never sleep. 

• S6 does not update the displayed setting for Solo switch (Intercancel versus Sum) after changing the Solo switch mode in 
Pro Tools (GWSW-8214)
Changing the Solo switch mode in Pro Tools does not always update the displayed state of Solo on S6. Switch behavior correctly 
follows the selected mode on the specific workstation on which it was configured, it is only the displayed setting on S6 that does 
not update. 
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Layouts

3rd Party EUCON applications only: Newly added Tracks can be lost from Layouts after disconnecting a workstation or 
changing the designated Layout Store workstation before closing a session (GWSW-9334)

This component of GWSW-9334 affects 3rd party (non-Pro Tools) EUCON applications only. If you add one or more tracks to a 
Layout and then disconnect the designated workstation before saving the session/project, those recently added tracks may not be 
recalled when the workstation is reconnected and that session/project is reopened. 

Workaround: Close and save the session before either disconnecting its workstation, or designating a different Layout Store 
workstation. If you do disconnect while a session is open, don’t save it until after you have reconnected the workstation to S6. 

After using Import Session Data (Pro Tools), S6 Layouts fail to recall stored knob assignments (GWSW-9285)

Monitoring

Monitoring page inactive unless Monitoring application Is focused

The S6 Monitoring page does not show sources unless the monitoring application (such as XMON EUCON) is focused on the 
workstation, even if the S6 Monitoring section is locked to the monitoring application. 

XMON: Audio passes through even when no sources are selected on first launch after installation (GWSW-7169)
Workaround: Select your Source from the XMON application, quit and relaunch. 

DADMan: Source selection Sum and Intercancel mode setting conflicts with S6 Monitoring mode setting (GWSW-9640)

The S6 Monitoring local options page lets you configure Source selection for Sum or Intercancel mode, and this setting can conflict 
with the same settings available in DADMan preferences. 

Workaround: Do either of the following: 
• In the S6 Monitoring local options, set Source selection to Sum mode and then only use DADMan preferences to switch 

modes. 
• Configure DADMan preferences to Sum and only use S6 to switch modes. 

Master Joystick Module

When using the Master Joystick Module to pan a stereo track with Stereo Link enabled, touching both joysticks 
simultaneously can lock up the pan position of one side of the stereo signal when only one joystick is released 
(GWSW-9080)

Workaround: Let go of both joysticks then touch or move either to re-establish stereo linked panning. 





Technical Support (USA)
Visit the Online Support Center 
at www.avid.com/support

Product Information
For company and product informa-
tion, visit us on the web at www.av-
id.com
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